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Introduction 
Learn-by-Doing: Microsoft 365 - Excel 
(Level 2) 
The Learn-by-Doing: Microsoft 365 Series consists of Level 1 and Level 2. As the name implies, the Learn-by-Doing 
Series gets students learning Microsoft 365 by using its applications to communicate and collaborate in the real 
world of work and life. This series uses step-by-step instructions and illustrative screenshots to introduce and 
reinforce essential skills needed to demonstrate workplace productivity principles in Word, Excel, and PowerPoint. 

Designed for today’s interactive, visual learner, Learn-by-Doing: Microsoft 365 - Excel (Level 2) uses a graphical, 
screenshot-based approach to support students in mastering the advanced tools and features of Microsoft Excel. 
Students already familiar with the basics of Excel will explore advanced skills—such as using logical functions, 
recording macros, and creating PivotTables and advanced charts—in an illustrated, step-by-step format, helping 
them gain valuable workplace skills and master this essential business application. 

This text is designed to be used by students enrolled in a computer applications course that includes using 
spreadsheets in its curriculum and assumes students have already mastered beginner to intermediate skills, 
including those presented in Level 1 of this series. This text is also designed for learners looking to learn and 
practice all the advanced skills assessed on the Microsoft Office Specialist (MOS) Excel Expert Certification Exam. 
The lessons in this book present groups of related Excel skills and features according to their function within the 
application and build upon knowledge as it is acquired. Therefore, lessons should be completed in the order 
presented. 

Microsoft Office Specialist Certification 
Microsoft Office Specialist (MOS) is an industry-leading certification by Certiport designed to assess mastery of 
Microsoft 365 applications. Candidates are evaluated on their ability to apply their knowledge of important 
application features in a project-based environment. Certified Microsoft Office Specialists demonstrate 
internationally-recognized skills that can be leveraged for future success in both the classroom and the workplace. 
To support students seeking advanced MOS certification, this text provides detailed instruction and assessment in 
all the skills assessed on the MOS Excel Expert Certification Exam. 

What Is Microsoft 365? 
Microsoft 365 is a subscription service (offered by Microsoft) providing users with a suite of some of the most 
commonly used productivity applications, including Word, Excel, PowerPoint, and more. It also offers users cloud 
storage and online collaboration features via OneDrive, providing one central online location to save and manage 
work. To help users create and share documents across all devices, Microsoft 365 includes simplified, web-based 
versions of Excel and other applications. Working in this online environment, however, does not offer the full, robust 
features available in the desktop version of Excel. 
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Because several of the application’s more complex tools and features are unavailable when using Excel for the 
web, advanced users typically utilize the desktop version of Excel. Additionally, saving files to OneDrive may make 
it difficult to work with spreadsheets involving macros.  

Prerequisite Skills 
Learn-by-Doing: Microsoft 365 - Excel (Level 2) should be used by students who are already familiar with beginner 
to intermediate Excel skills. Because mastering Microsoft Excel’s advanced tools and features requires prior 
knowledge of workbook basics and core spreadsheet skills and concepts, students should have experience with 
skills such as those presented in Level 1 of this series. Click the link below for a complete list of skills you should 
understand before completing the lessons in this book.  

Learn-by-Doing: Microsoft 365 - Excel (Level 1) Curriculum Guide 

How to Use This Book  
The instructions and screenshots included in each lesson have been authored to correspond to the most recent 
desktop version of Microsoft Excel. Using this version of Excel—and not the online version of the application 
included with Microsoft 365 subscriptions—will allow you to use the advanced features described in this text and 
ensure lesson instructions and screenshots align with your application.  

Throughout this text, you will be instructed to access Lesson Source Files, which will be provided by your 
instructor. Lesson Source Files provide the initial data, layout, and structure of the spreadsheet required to begin 
each lesson, allowing you to focus on learning the advanced skills presented rather than on keying data and 
constructing basic spreadsheets. Since these lessons are designed to reduce start-up time before encountering the 
key skills, this book can be completed in approximately 25-31 hours.  

Note: The content and data presented in these Lesson Source Files are for instructional purposes only and do not 
necessarily represent factual information.  

You will also be guided on where to save your completed work. Before you begin completing any lessons, you will 
create a folder on your local or network drive called My Advanced Excel Projects. You will save all Lesson Source 
Files and completed work to this local folder—and not to a cloud server such as OneDrive—except where noted. 

Note: Your instructor will also provide you with specific instructions on where to create your My Advanced Excel 
Projects folder and preferences for how to share or submit your completed work. Some skills presented in this text 
can only be measured through teacher observation rather than in the production of a final workbook. In these 
instances, you may be required to demonstrate your successful completion of the skill as your instructor views 
your screen. 
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Understanding the Format of This Book 
This book is divided into four units, each containing individual lessons pertaining to advanced tools and features 
available in Excel. Lessons in this book have been organized into an easy-to-read, self-guided, visual format where 
you encounter and practice new skills and learn by doing. 

Review the following features and components to become familiar with the structure of the lessons in Learn-by-
Doing: Microsoft 365 - Excel (Level 2). 

 

Features & Components 
1 Lesson Title 

2 Lesson Overview 

Explains the core Microsoft Excel tools and 
spreadsheet concepts that will be explored in the 
lesson. Lesson overviews offer important background 
about the skills introduced in the lesson and present a 
clear explanation as to why and how those skills are 
utilized in particular workbooks. Reading these 
overviews will prepare you with the knowledge you 
need to use advanced tools and features of Excel 
within the real-world context featured in the lesson. 

3 Skills 

Lists the new skills introduced in the lesson. All skills 
assessed in the MOS Excel Expert Certification Exam 
are taught in this text. 

4 Your Task 

Describes how you will utilize the new skills in a 
workbook. 

5 Tools & Terms 

Illustrates the icons, features, functions, and menu 
descriptions related to the core concepts explored in 
the lesson. 

 

 
 

 

1 

2 3 

4 

5 
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6 Instructions 

Step-by-step instructions allow you to complete 
lessons accurately and learn and master how to use 
advanced tools. Notes providing learning 
opportunities (in shaded areas) are also included to 
expand instruction on new skills and offer context for 
a feature’s real-world use.  

7 Screenshots 

Instructions that are illustrated with corresponding 
drop-down menus and dialog boxes are indicated by a 
yellow # icon. Match each instruction with its 
corresponding screenshot as you complete the step. 

Note: Once a new skill has been presented, visual 
step-by-step instructions for that skill are no longer 
provided in subsequent lessons. 

Note: Since Microsoft 365 subscriptions provide 
regular, frequent application updates, screenshots 
presented may differ and instructions may require 
minor modifications. 

 

 

Skills Mastery 
Upon completion of all the lessons in each unit, you may 
be required to complete a series of Skills Mastery 
Assessments. These quizzes and tests offer you the 
opportunity to demonstrate mastery of new skills and 
assess your knowledge of the advanced features of 
Excel. Skills Mastery Assessments for each unit are 
located with the Instructor Resources. 

 

6 

7 
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Curriculum Guide 
Lesson  Skills 

Approximate 
Completion Time 

(in hours) 

Unit 1: Managing Workbook Options  

1.1 Managing Version History  Manage workbook versions .75 

1.2 Collaborating Using 
Comments 

 Manage comments .75 

1.3 Translating Data  Configure edi�ng and display languages 
 Translate data 

.75 

1.4 Creating External References  Reference data in other workbooks .75 

1.5 Protecting Your Data  Restrict edi�ng 
 Protect worksheets and cell ranges 
 Protect workbook structure 

.75 

Unit 1 Skills Mastery  Skills Mastery Quizzes and Tests are located with the Instructor Resources 

Unit 2: Managing and Formatting Data 

2.1 Filling Data in a Series  Fill cells by using Flash Fill 
 Fill cells by using advanced Fill Series op�ons 
 Generate numeric data by using the RANDARRAY func�on 

.75-1 

2.2 Using Custom Number 
Formats 

 Create custom number formats .75-1 

2.3 Setting Data Validation  Configure data valida�on 1 

2.4 Outlining Data  Group and ungroup data 
 Calculate data by inser�ng subtotals and totals 
 Remove duplicate records 

1 

2.5 Using Conditional Formatting  Create custom condi�onal forma�ng rules 
 Manage condi�onal forma�ng rules 

.75-1 

2.6 Recording and Running 
Macros 

 Record simple macros 
 Name simple macros 

.75-1 

2.7 Modifying and Copying 
Macros 

 Enable macros in a workbook 
 Edit simple macros 
 Copy macros between workbooks 

.75 

Unit 2 Skills Mastery  Skills Mastery Quizzes and Tests are located with the Instructor Resources 
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Lesson  Skills 

Approximate 
Completion Time 

(in hours) 

Unit 3: Creating Advanced Formulas  

3.1 Using Logical Functions  Perform logical opera�ons by using the IF, AND, OR, and NOT 
func�ons 

 Create condi�onal forma�ng rules that use formulas 
 Validate formulas by using error checking rules 

1-1.5 

3.2 Building Nested Formulas  Perform logical opera�ons by using nested formulas including 
the IF, AND, OR, and NOT func�ons 

 Evaluate formulas 

1-1.5 

3.3 Testing for Multiple 
Conditions 

 Perform logical opera�ons by using nested formulas including 
the IFS and SWITCH func�ons 

 Monitor cells and formulas by using the Watch Window 

1 

3.4 Using Conditional Functions  Perform logical opera�ons by using the SUMIF, AVERAGEIF, 
COUNTIF, SUMIFS, AVERAGEIFS, COUNTIFS, MAXIFS, and 
MINIFS func�ons 

1-1.5 

3.5 Using the LET Function  Perform logical opera�ons by using nested formulas including 
the LET func�on 

 Trace precedents and dependents 

1-1.5 

3.6 Using Lookup Functions  Look up data by using the XLOOKUP, VLOOKUP, HLOOKUP, 
MATCH, and INDEX func�ons 

1-1.5 

3.7 Working with Dates and 
Times 

 Reference date and �me by using the NOW and TODAY 
func�ons 

 Calculate dates by using the WEEKDAY and WORKDAY func�ons 
 Configure formula calcula�on op�ons 

1 

3.8 Consolidating Data  Summarize data from mul�ple ranges by using the Consolidate 
feature 

.75 

3.9 Performing What-If Analysis  Perform what-if analysis by using Goal Seek and Scenario 
Manager 

1 

3.10 Performing Financial 
Calculations 

 Calculate financial data by using the PMT func�on 
 Forecast data by using the AND, IF, and NPER func�ons 

1-1.5 

3.11 Using Functions to Sort and 
Filter Data 

 Filter data by using FILTER 
 Sort data by using SORTBY 

.75 

Unit 3 Skills Mastery  Skills Mastery Quizzes and Tests are located with the Instructor Resources 
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Lesson  Skills 

Approximate 
Completion Time 

(in hours) 

Unit 4: Managing Advanced Charts and Tables 

4.1 Creating Advanced Charts  Create and modify charts including Box & Whisker, Funnel, 
Histogram, and Waterfall charts 

1-1.5 

4.2 Creating More Advanced 
Charts 

 Create and modify dual-axis charts 
 Create and modify charts including Combo and Sunburst charts 

1-1.5 

4.3 Generating and Modifying 
PivotTables 

 Create PivotTables 
 Modify field selec�ons and op�ons 
 Group PivotTable data 

1-1.5 

4.4 Configuring PivotTable Value 
Fields 

 Create slicers 
 Add calculated fields 
 Configure value field se�ngs 

1-1.5 

4.5 Creating PivotCharts  Create PivotCharts 
 Manipulate op�ons in exis�ng PivotCharts 
 Apply styles to PivotCharts 
 Drill down into PivotChart details 

1 

Unit 4 Skills Mastery  Skills Mastery Quizzes and Tests are located with the Instructor Resources 

  Total Approximate Completion Time:  25-31 hrs. 
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Skills Correlations 
Microsoft Office Specialist Excel 365 Expert Certification 
(Exam MO-211) 
Learn-by-Doing: Microsoft 365 - Excel (Level 2) is 100% aligned to the skills assessed in Certiport’s Microsoft Office 
Specialist Excel Expert Certification Exam. The following includes the Objective Domains (skills) covered on the 
certification exam, the correlating lesson(s) in which the skills are taught, and Skills Mastery quizzes and tests in which 
they are assessed. 

Objective Domain (Skill) 
Textbook Lesson  

Number 
Skills Mastery  

Quiz/Test 

Manage Workbook Options and Settings   

Manage workbooks   

Copy macros between workbooks 2.7 Quiz 2.5 
Test 2 

Reference data in other workbooks 1.4 Quiz 1.3 
Test 1 

Enable macros in a workbook 2.7 Quiz 2.5 
Test 2 

Manage workbook versions 1.1 Quiz 1.1 
Test 1 

Prepare workbooks for collaboration   

Restrict editing 1.5 Quiz 1.2 
Test 1 

Protect worksheets and cell ranges 1.5 Quiz 1.2 
Test 1 

Protect workbook structure 1.5 Quiz 1.2 
Test 1 

Configure formula calculation options 3.7 Quiz 3.6 
Test 3 

Manage and Format Data   

Fill cells based on existing data   
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Objective Domain (Skill) 
Textbook Lesson  

Number 
Skills Mastery  

Quiz/Test 

Fill cells by using Flash Fill 2.1 Quiz 2.1 
Test 2 

Fill cells by using advanced Fill Series options 2.1 Quiz 2.1 
Test 2 

Generate numeric data by using RANDARRAY() 2.1 Quiz 2.1 
Test 2 

Format and validate data   

Create custom number formats 2.2 Quiz 2.2 
Test 2 

Configure data validation 2.3 Quiz 2.3 
Test 2 

Group and ungroup data 2.4 Quiz 2.4 
Test 2 

Calculate data by inserting subtotals and totals 2.4 Quiz 2.4 
Test 2 

Remove duplicate records 2.4 Quiz 2.4 
Test 2 

Apply advanced conditional formatting and filtering   

Create custom conditional formatting rules 2.5 Quiz 2.2 
Test 2 

Create conditional formatting rules that use formulas 3.1 Quiz 3.2 
Test 3 

Manage conditional formatting rules 2.5 Quiz 2.2 
Test 2 

Create Advanced Formulas and Macros   

Perform logical operations in formulas   

Perform logical operations by using nested functions including the 
IF(), IFS(), SWITCH(), SUMIF(), AVERAGEIF(), COUNTIF(), SUMIFS(), 
AVERAGEIFS(), COUNTIFS(), MAXIFS(), MINIFS(), AND(), OR(), 
NOT(), and LET() functions  

3.1, 3.2, 3.3,  
3.4, 3.5 

Quiz 3.1, 3.3 
Test 3 

Look up data by using functions   

Look up data by using the XLOOKUP(), VLOOKUP(), HLOOKUP(), 
MATCH(), and INDEX() functions 

3.6 Quiz 3.2 
Test 3 
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Objective Domain (Skill) 
Textbook Lesson  

Number 
Skills Mastery  

Quiz/Test 

Use advanced date and time functions   

Reference date and time by using the NOW() and TODAY() 
functions 

3.7 Quiz 3.6 
Test 3 

Calculate dates by using the WEEKDAY() and WORKDAY() functions 3.7 Quiz 3.6 
Test 3 

Perform data analysis   

Summarize data from multiple ranges by using the Consolidate 
feature 

3.8 Quiz 3.4 
Test 3 

Perform what-if analysis by using Goal Seek and Scenario Manager 3.9 Quiz 3.4 
Test 3 

Forecast data by using the AND(), IF(), and NPER() functions 3.10 Quiz 3.7 
Test 3 

Calculate financial data by using the PMT() function 3.10 Quiz 3.7 
Test 3 

Filter data by using FILTER() 3.11 Quiz 3.5 
Test 3 

Sort data by using SORTBY() 3.11 Quiz 3.5 
Test 3 

Troubleshoot formulas   

Trace precedents and dependents 3.5 Quiz 3.2 
Test 3 

Monitor cells and formulas by using the Watch Window 3.3 Quiz 3.3 
Test 3 

Validate formulas by using error checking rules 3.1 Quiz 3.4 
Test 3 

Evaluate formulas 3.2 Quiz 3.3 
Test 3 

Create and modify simple macros   

Record simple macros 2.6 Quiz 2.5 
Test 2 

Name simple macros 2.6 Quiz 2.5 
Test 2 
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Objective Domain (Skill) 
Textbook Lesson  

Number 
Skills Mastery  

Quiz/Test 

Edit simple macros 2.7 Quiz 2.5 
Test 2 

Manage Advanced Charts and Tables   

Create and modify advanced charts   

Create and modify dual axis charts 4.2 Quiz 4.2 
Test 4 

Create and modify charts including Box & Whisker, Combo, Funnel, 
Histogram, Sunburst, and Waterfall charts 

4.1, 4.2 Quiz 4.1, Quiz 4.2 
Test 4 

Create and modify PivotTables   

Create PivotTables 4.3 Quiz 4.3 
Test 4 

Modify field selections and options 4.3 Quiz 4.3 
Test 4 

Create slicers 4.4 Quiz 4.3 
Test 4 

Group PivotTable data 4.3 Quiz 4.3 
Test 4 

Add calculated fields 4.4 Quiz 4.3 
Test 4 

Configure value field settings 4.4 Quiz 4.3 
Test 4 

Create and modify PivotCharts   

Create PivotCharts 4.5 Quiz 4.4 
Test 4 

Manipulate options in existing PivotCharts 4.5 Quiz 4.4 
Test 4 

Apply styles to PivotCharts 4.5 Quiz 4.4 
Test 4 

Drill down into PivotChart details 4.5 Quiz 4.4 
Test 4 

 

For Evaluation Purposes Only



Unit 3 | Creating Advanced Formulas Lesson 3.1 | Using Logical Functions 

Learn-by-Doing: Microsoft 365 - Excel (Level 2) 67 

Lesson 3.1 

Using Logical Functions 

Overview 
Learning and mastering Excel’s logical functions is a great way to place 
the full power of the software in your hands. This useful and popular 
category of functions allows you to test your data for certain 
characteristics, then perform specific tasks based on the results. What 
makes logical functions unique is that they are built around the 
mathematical concept of logical operators, evaluating an expression 
(such as “A5>10”) as either TRUE or FALSE. 

Logical operators such as “and,” “or,” and “not” are a fundamental 
concept in computer science used to test whether an expression is true 
or false based on various conditions. They are used in programming, 
search engine queries, and even in everyday language like “I will 
subscribe to Netflix or Hulu this month.” In Excel, these logical operators 
correspond to functions, all of which test conditions in your spreadsheet 
and return a value of either TRUE or FALSE. 

The AND function allows you to test whether several different 
conditions are all true. For example, you may want to check that the 
value of one cell is equal to another and that it is greater than a certain 
number. If both of those conditions are met, the function will return a 
value of TRUE; otherwise, it will return FALSE. The OR function works in 
a similar way, but it will return TRUE as long as at least one of the 
conditions you set is met. 

Unlike AND and OR, the IF function only tests one condition, however it 
allows you to set a specific string of text to return if the condition is true 
and another if it is false. NOT is used to reverse the result of a logical 
expression from TRUE to FALSE and vice versa. While each of these 
logical functions can be useful on their own, combining them into 
complex nested formulas allows you to take advantage of the full power 
of Excel’s logical functions. 

Skills 
 Perform logical operations by using 

the IF, AND, OR, and NOT functions 
 Create conditional formatting rules 

that use formulas 
 Validate formulas by using error 

checking rules 
 

Your Task 
In this lesson, you will build formulas 
using the logical operators AND, OR, 
IF, and NOT and use logical functions 
in custom conditional formatting 
rules. You will also review error 
checking rules that impact formulas. 
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Tools & Terms 
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Assessments for this Unit. 

 

Logical Functions: 
In Excel, logical functions are a category of functions that test for specific conditions, evaluate them as TRUE or FALSE, and 
perform a specific action as a result. Like most functions in Excel, each logical function has specific arguments, or components 
of the function’s syntax required to work correctly. In logical functions, the key arguments are expressions to be tested. 
Expressions are combinations of values, cell references, and operators like >, <, and = that are evaluated as either TRUE or 
FALSE. As you work with logical functions, pay attention to the required arguments, and remember that each function works by 
evaluating expressions as either TRUE or FALSE, and each expression, or condition to be tested, is separated by a comma. 

 

 
AND: 
Use this function to test whether all the conditions you set 
are true. If so, it will return TRUE; if not, it will return 
FALSE. 

 
 

NOT: 
Use this function to reverse the value of a logical 
expression. It will return FALSE if the condition you set is 
met and TRUE if the condition is not met. 

 
 

OR: 
Use this function to test whether at least one of the 
conditions you set is true. If so, it will return TRUE; if not, it 
will return FALSE. 

 

IF: 
Use this function to test for a condition and return a 
specific value if the condition is met or not met. 

 

Logical test: The expression to be tested 

Value if true: The response to return if the expression is 
true 

Value if false: The response to return if the expression is 
false 

 

Error Checking: 
Use this feature to validate formulas in your spreadsheet 
and address any issues or errors. 
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Instructions 
1. Launch Excel and open the file named Lesson 3.1 SOURCE. 

2. Save the file as Lesson 3.1 in your My Advanced Excel Projects folder. 

3. Review the workbook to become familiar with the content and format of this file. Notice the budgeted 
amounts in column B compared with the money actually spent in columns C through E. 

When working with formulas in Excel, it’s not uncommon to create errors with the syntax of functions and the 
arguments they require to work, or to create formulas that don’t produce the results you intend. In these 
instances, Excel attempts to recognize errors with your formulas and alert you by placing a small green flag in the 
upper left corner of the cell. The Error Checking feature can provide some clues as to what may be wrong and 
offer suggestions for fixing formulas. 

4. To use the Error Checking feature to validate formulas in your workbook, do the following: 

a. In cell B34, key the formula [=SUM(B5:B32)] exactly as shown. Notice that this formula leaves out cell B33 
when calculating the total of the amount budgeted in column B. 

b. Select cell B34 and notice the green flag that appears in the upper left corner of the cell. Click the drop-
down menu and notice the options for investigating the error. 

 

c. To review the error in detail, from the Formulas tab, Formula Auditing group, click Error Checking. 

 

d. In the Error Checking dialog box, read the explanation provided for the error, indicating that some cells 
have been left out of the formula.  

e. Click Update Formula to Include Cells to fix the error, then click OK to return to the worksheet. 

 

 Note: You can review additional error checking rules from the Excel Options dialog box, Formulas tab. 

f. Copy the corrected formula in cell B34 into cells C34 through E34. 

4b 

4c 

4e 
4d 
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In Excel, logical operators such as “and,” “or,” and “not” correspond to functions you can use to test your data for 
various conditions. Understanding the logic behind how each of these functions work will help you better use 
these tools to build complex formulas, and Excel also includes some features to help you with formulas. For 
example, as you begin to key a function, the formula bar will display text guiding you to enter the expected 
arguments. Pay attention to this help text as you use a variety of logical functions in this lesson to quickly analyze 
your data based on different factors. 

5. To use the AND function to test whether the amounts spent in January through March were all more than 
what was budgeted, do the following: 

a. In cell G4, key the text [Within Budget EVERY Month?]. 

b. In cell G5, key the following formula: 

=AND(B5>=C5,B5>=D5,B5>=E5) 

 Note: This will check whether the amount budgeted in B5 is greater than or equal to all the values in 
cells C5 through E5 (January through March). If the expense is within budget all three months, it will return 
“TRUE”; otherwise, it will return “FALSE”. A comma separates each expression that must be met in order to 
return “TRUE”. 

 

 

c. Copy the formula down through row 34 and review the results to analyze the logic of the AND function 
resulting in a TRUE or FALSE value. 

 Note: When working with functions in Excel, it is important to always check cell number formats to 
ensure that the results display correctly according to the value you expect each function to return (text, 
numbers, dates, etc.). Throughout this text, adjust number formatting as needed. 

 

6. To use the OR function to test whether at least one of the amounts spent in January through March was more 
than what was budgeted, do the following: 

5c 
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a. In cell H4, key the text [Within Budget ANY Month?]. 

b. In cell H5, key the following formula: 

=OR(B5>=C5,B5>=D5,B5>=E5) 

 Note: This will check whether the amount budgeted in cell B5 is greater than or equal to at least one of 
the values in cells C5 through E5 (January through March). If the expense was within budget in any of the 
three months, it will return “TRUE”; otherwise, it will return “FALSE”. 

 

 

c. Copy the formula down through row 34 and review the results to analyze the logic of the OR function 
resulting in a TRUE or FALSE value. 

 

While the AND and OR functions can test for multiple conditions, each separated by a comma, the NOT function 
only tests one condition. Since the NOT function is used to negate an expression, it will return “TRUE” if the 
condition is not met and “FALSE” if the condition is met. On its own, the NOT function has limited use, but it can 
be a powerful tool when used in combination with other logical operators (explored in a later lesson). 

7. To use the NOT function to reverse the logic of a statement from TRUE to FALSE and vice versa (to check if the 
amount budgeted was not more than 500), do the following: 

a. In cell I4, key the text [NOT a Major Expense?]. 

b. In cell I5, key the following formula: 

=NOT(B5>=500) 

 Note: This will check whether the value of cell B5 is greater than or equal to 500, making it a major 
expense. Since the NOT function is used to negate an expression, it will return “TRUE” if the value is under 
500 and “FALSE” if the value is over 500. 

6b 
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c. Copy the formula down through row 34. Notice that cell I6 returns [FALSE] because cell B6 indicates that it 
is a major expense (500). Cell I7, meanwhile, shows [TRUE] because cell B7 indicates that it is not a major 
expense (only 150). 

 

The IF function is a useful logical function in Excel that tests whether a condition is true, then returns any value you 
specify if the condition is met or not met. On its own, the IF function only tests for one condition (unlike AND and 
OR), however when used in combination with other logical operators in complex nested logical formulas (explored 
in a later lesson) it can be extremely powerful and flexible. 

8. To use the IF function to test whether the amount spent in January was within the amount budgeted, and 
return a specific value if the condition is met or not met, do the following: 

a. In cell J4, key the text [Within Budget in January?]. 

b. In cell J5, key the following formula:  

=IF(B5>=C5,"We were within budget for this expense in January","We spent more for this expense in 
January than budgeted")  

 Note: This will check whether the amount budgeted in cell B5 is greater than or equal to the value of 
cell C5 (what was spent in January). If the condition is met, it will return the first string of text in quotations; 
if it is not met, it will return the second string of text in quotations. 

 

 

7b 
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c. Copy the formula down through row 33. Notice that cell J16 shows that the expense for January (cell C16) 
was within budget (cell B16), while cell J17 shows that the expense was not within budget in January. 

 

Logical functions can also be used in combination with conditional formatting. If the formula you enter in a new 
custom conditional formatting rule evaluates as true, it will format the cells according to your specifications; if the 
formula evaluates as false, the cell will not be formatted. 

9. To create a new custom conditional formatting rule using logical functions, select cells C5 through C33, then 
do the following: 

a. From the Home tab, Styles group, Conditional Formatting drop-down menu, click New Rule…. 

b. In the New Formatting Rule dialog box, Select a Rule Type section, select Use a formula to determine 
which cells to format. 

c. In the Format values where this formula is true field, key the following formula: 

=AND(B5>=300,C5>B5) 

 

 Note: This will check whether the value in column B of each row within the range is greater than or 
equal to 300, and if the value in column C of each row is greater than that value. 

d. Set the conditional formatting rule to format cells that match the rule with Red font, then click OK. 

e. Create similar conditional formatting rules for cells D5 through D33 and cells E5 through E33 that apply red 
font to values that are over budget and were budgeted greater than or equal to 300. 

10. Review your finished workbook and proofread all changes made to the file, then resave. 

11. Print or share the workbook if required by your instructor. 

8c 
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Lesson 3.2 

Building Nested Formulas 

Overview 
Each logical function in Excel has a variety of uses for many different 
real-world scenarios, however building complex formulas that utilize 
many different functions together will unlock the full power of these 
tools. When one function is used inside another it is called nesting. In 
nested formulas, the primary function (after the equal sign) uses the 
result of another function as one of its arguments, or components. 

To build nested formulas, you must first understand all of the 
arguments required by the functions you are using (usually separated by 
commas). For example, the IF function requires three arguments: an 
expression to be checked, the text to return if it is true, and the text to 
return if it is false. By replacing the first argument of the IF function—the 
expression to be tested—with the result returned by the AND function, 
you can use the IF function to check for multiple conditions and return 
any value that you want. Combining these functions together expands 
the power of both the IF function and the AND function. 

Reading and writing nested formulas can be tricky, so pay close 
attention to the parentheses required by each function. It may also be 
helpful to read the formula “inside out,” beginning with the innermost 
function. Think about the value that function will return (which in the 
case of logical functions is either TRUE or FALSE), then determine what 
effect that value has as the argument for the surrounding function. 
Another helpful tool is the Evaluate Formula feature, which allows you 
to inspect how each element of a formula is calculated to fix any issues 
or learn more about how the functions work. 

Skills 
 Perform logical operations by using 

nested formulas including the IF, 
AND, OR, and NOT functions 
 Evaluate formulas 
 

Your Task 
In this lesson, you will build nested 
formulas by combining the logical 
functions AND, OR, IF, and NOT. You 
will also use the Evaluate Formula 
feature to inspect how complex 
formulas are calculated. 

 

Tools & Terms 
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Assessments for this Unit. 

 
Nested Formulas: 
Combining two or more functions into one formula can 
help you perform a wide range of powerful tasks. When 
reading nested formulas, pay close attention to the 
parentheses of each function and the arguments required. 

 

Evaluate Formula: 
Use this feature to help inspect or correct nested formulas 
by revealing how each component is calculated. 
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Instructions 
1. Launch Excel and open the file named Lesson 3.2 SOURCE. 

2. Save the file as Lesson 3.2 in your My Advanced Excel Projects folder. 

3. Review the workbook to become familiar with the content and format of this file. Notice that the grade book 
contains grades for each student. Notice that the Semester 1 Averages in column P refer to the grades in 
columns C through H, while the Semester 2 Averages in column Q refer to the grades in columns I through N. 

The logical functions you have previously learned can be combined to build complex nested formulas that test 
your data for various characteristics. One function can be used within another (typically the IF function) to expand 
and enhance the power of each function.  

In this lesson, you will create nested formulas testing the grade book data for various conditions, determining 
whether each student is eligible to receive a prize based on their performance. When building nested formulas, 
pay careful attention to the parentheses belonging to each function and be sure that each argument required by 
the function is present and expressed correctly. 

4. To use a nested formula with the IF and AND functions to test whether a student will earn a gift card if they 
had perfect attendance and a final grade score of 80 or higher, do the following: 

a. In cell S4, key the text [Attendance Award]. 

b. In cell S5, key the following formula: 

=IF(AND(B5="Yes",R5>=80),"Gift Card","") 

 Note: This will check whether the value in cell B5 is “Yes” (indicating perfect attendance) and that the 
student’s Final Grade (column R) is greater than or equal to 80. It will return the student’s prize “Gift Card” 
if true and nothing (indicated by the final set of empty quotation marks) if false.  

 

 

c. Copy the formula down through row 24. Notice that Alexander Martin will receive a gift card (cell S5) 
because his final grade was 81.53 and he recorded perfect attendance. Ava Lee will not receive a gift card 
(cell S6). She had a final grade of 87.40 but did not record perfect attendance. 

 

4b 
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 Note: When working with functions in Excel, it is important to always check cell number formats to 
ensure that the results display correctly according to the value you expect each function to return (text, 
numbers, dates, etc.). Throughout this text, adjust number formatting as needed. 

5. To use a nested formula with the IF and OR functions to test whether each student had any test or exam score 
of 90 or higher, do the following: 

a. In cell T4, key the text [High Performer Award]. 

b. In cell T5, key the following formula: 

=IF(OR(H5>=90,N5>=90,O5>=90),"Candy","") 

 Note: This will check whether any ONE of the student’s test or exam scores (columns H, N, and O) are 
greater than or equal to 90. It will return “Candy” if true and nothing if false. 

 

 

c. Copy the formula down through row 24. Notice that Emily Johnson will receive candy (cell T10) because 
she had at least one test or exam score of 90 or more. Emma Taylor will not receive candy (cell T11) 
because she had no test or exams of at least 90. 

 

6. To use a nested formula with the IF, AND, and NOT functions to test whether each student had a higher 
second semester average than first semester average and got a final exam score higher than 80, do the 
following: 

a. In cell U4, key the text [Improvement Award]. 

b. In cell U5, key the following formula: 

=IF(AND(Q5>P5,NOT(O5<=80)),"Certificate","") 

 Note: This will check whether the student’s semester 2 average (column Q) is greater than their 
semester 1 average (column P) and that their final exam score is not less than or equal to 80 (higher than 
80). It will return “Certificate” if true and nothing if false.  

5b 
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c. Copy the formula down through row 24. Notice that Ava Lee will receive a certificate (cell U6) because her 
Semester 2 Average was greater than her Semester 1 Average and she received an 89 on the Final Exam 
(which was higher than 80). Benjamin Miller will not receive a certificate (cell U7) because his Semester 2 
Average was less than his Semester 1 Average. 

 

Nested formulas can contain other functions besides logical functions. Combining functions of different types such 
as this is a great way to have Excel perform a range of different tasks, sometimes even inside a single formula. 

7. To build a nested formula with the IF, AND, and MIN functions to test whether each student got a score of 70 
or higher on all grades and had a final grade of 90 or higher, do the following: 

a. In cell V4, key the text [Consistency Award]. 

b. In cell V5, key the following formula: 

=IF(AND(MIN(C5:O5)>=70,R5>=90),"Pizza Party","") 

 Note: This will check whether the lowest value of ALL the student’s scores (using the MIN function for 
columns C through O) is greater than or equal to 70 and that their final grade (column R) is greater than or 
equal to 90. It will return “Pizza Party” if true and nothing if false. 

 

 

c. Copy the formula down through row 24. Notice that Benjamin Miller will receive a pizza party (cell V7) 
because his Final Grade was 94.73 and he had no grades below 70. Christopher Robinson will not receive a 
pizza party (cell V8) because one of his quiz scores (cell C8) was below 70. 

6b 
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8. Use cell shading or borders of your choice to format the related awards information in columns S through V. 

If you are working on a spreadsheet with long, complicated formulas (especially ones you didn’t create yourself), it 
may be difficult to understand at a glance exactly what each one is calculating. The Evaluate Formula feature 
allows you to inspect a formula the way Excel itself calculates it. You can review each expression independently to 
study which element the software calculates first and see the results along the way. You can also “step into” 
expressions that reference other cells or ranges to see how those original cells are calculated as well. 

9. To use the Evaluate Formula feature to review how each expression in a nested formula is being calculated, 
select cell S5, then do the following: 

a. From the Formulas tab, Formula Auditing group, click Evaluate Formula. 

 

b. In the Evaluate Formula dialog box, notice that the formula selected is displayed in the Evaluation field. 
The first expression of the formula being evaluated is underlined. 

 

c. Click Evaluate and notice that B5 is filled in with the cell’s value (“Yes”). 

 

d. Click Evaluate again and notice that the expression “Yes”=”Yes” is simplified to TRUE. 

7c 
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e. Continue to click Evaluate to review how each step of the formula is completed, resulting in “Gift Card” 
being returned in cell S5. 

f. Click Restart to begin the process again. 

 

g. Continue to click Evaluate in the Evaluate Formula dialog box until the expression [R5] is underlined, then 
click Step In. 

 

h. Notice that a new level is displayed showing how the value in cell R5 is calculated. Continue to click Step In 
to evaluate each expression. 

 

i. Use the Evaluate Formula feature to review how other formulas in columns T through V are calculated. 

10. Review your finished workbook and proofread all changes made to the file, then resave. 

11. Print or share the workbook if required by your instructor. 
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Lesson 4.3 

Generating and Modifying PivotTables 

Overview 
PivotTables are an extremely powerful advanced Excel feature that 
allows you to quickly and easily analyze information and generate 
summaries to answer a variety of important questions about your data. 
The benefit of using PivotTables over regular tables in Excel (or other 
features that summarize data like Outline and Consolidate Data) is that 
PivotTables are designed to be rearranged and reorganized to perform 
whatever task you require. 

PivotTables work by listing all the columns in your original source data in 
the PivotTable Fields task pane, allowing you to intuitively drag and 
drop them to build the precise PivotTable you need. Each field can 
become a column or row in the resulting PivotTable, or it can become 
the values that fill in the data of the table. Fields can also be used as 
filters to let the user control exactly what the PivotTable reports. As you 
drag and drop fields, the PivotTable automatically updates on the fly. 

It can sometimes be challenging to find the perfect configuration of 
fields to build PivotTables when you first learn the feature, however the 
drag and drop interactivity of the PivotTable Fields task pane makes it 
easy to quickly try new combinations until you arrive at the most useful 
and meaningful result. PivotTables can be used to find totals of values in 
rows or columns, flip or “pivot” the rows and columns of your data to 
analyze the information by different categories, and more. 

Skills 
 Create PivotTables 
 Modify field selections and options 
 Group PivotTable data 
 

Your Task 
In this lesson, you will generate 
PivotTables from data, modify the 
selections and options of fields to 
create new configurations, and group 
values to create subsets. 

 

Tools & Terms 
Review the following tools that you will learn and practice using in this lesson. In addition, you may be required to 
demonstrate your knowledge of these tools by completing the Skills Mastery Assessments for this Unit. 

 
PivotTable: 
This feature analyzes and summarizes data by 
enabling users to create flexible tables and 
easily modify their structure on the fly. 

PivotTable Fields: 
Use this task pane to add, remove, and 
modify fields to build a PivotTable. Each 
column of the source data becomes a field 
that can be combined in a variety of ways to 
display different results. 

PivotTable Styles: 
This feature changes the style of PivotTables. 

Refresh: 
This feature refreshes your PivotTable if 
the source data changes. 

Report Layout: 
This feature changes the way PivotTables 
summarize data, including adding total rows 
or condensing the layout of information. 

Group: 
This feature creates subsets of values 
to display a list that is easier to view 
and analyze. 
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Instructions 
1. Launch Excel and open the file named Lesson 4.3 SOURCE. 

2. Save the file as Lesson 4.3 in your My Advanced Excel Projects folder. 

PivotTables are a powerful tool in Excel to create summaries of data that can be easily changed, updated, and 
adjusted to analyze and display information in different combinations for different purposes. PivotTables can be 
created from any table or cell range, however they are most useful and illuminating when working with data that 
conveys a range of both numerical and text-based information. The resulting PivotTables can perform calculations 
with the numerical data, and the text data can be used to manipulate the PivotTable to display useful information 
about different categories contained within your data. 

3. Review the workbook to become familiar with its content and format. Notice the various types of sales data 
including dates (column B), numerical information (columns C through E), and text data (columns A, F, and G). 

4. To create a PivotTable from the data in your worksheet, select cell A4, then do the following: 

a. From the Insert tab, Tables group, PivotTable drop-down menu, select From Table/Range. 

 

b. In the PivotTable from table or range dialog box, notice that Excel has automatically selected the range A4 
through G54, then click OK. 

 

c. Notice that a new sheet is created prompting you to choose from the list of fields in the PivotTable Fields 
task pane. 

PivotTables are built from combinations of Fields. Each column of your data is a field that you can assign to several 
categories—including Rows, Columns, Values, and Filters—to build your PivotTable. Simply dragging and dropping 
fields into each area of the PivotTable Fields task pane builds your PivotTable and updates it on the fly as fields are 
added, removed, and reordered. Each combination of fields can display a different summary of your data and 
provide valuable insight to the reader. 

4a 
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5. To begin building your PivotTable from the list of available fields, from the PivotTable Fields task pane on the 
[Sheet1] worksheet, do the following: 

a. Notice the columns in the original data are available as filters. Click and drag the Product field to the Rows 
area of the task pane. Notice that the PivotTable has generated a list of each product as a row. 

 Note: Double clicking fields will also assign them to areas of the PivotTable, however clicking and 
dragging offers more precision and flexibility. 

 

b. To display a value next to each product to summarize the data, click and drag the Total Sale field to the 
Values area. Notice that a column is added to the PivotTable displaying the sum of all the values in the 
Total Sale column of the original data related to each product. A Grand Total is displayed at the bottom of 
the PivotTable. 

 

5a 
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c. To add an additional level of information, click and drag the Region field below Product in the Rows area. 
Notice that each product appears broken down by Region, showing the sum total of sales made in each 
region, for each product. 

 

d. In the Rows area of the PivotTable Fields task pane, drag the Region field above Product in the list. Notice 
that the PivotTable updates to display the total of each region, subsequently broken down by product. 

 

 Note: Much of the power of PivotTables to create meaningful summaries of your data comes from the 
flexibility of adding and rearranging fields. Fields can be dragged and dropped into each area to “pivot” the 
resulting table to display a new set of relevant information. 

5c 
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e. To remove a field from the PivotTable, select the Region field in the Rows area of the PivotTable Fields 
task pane and drag it over an empty cell in the worksheet. When your mouse displays an X icon, release to 
delete the field. 

 

f. Drag the Region field from the list of available fields into the Columns area. Notice that the PivotTable 
displays a column for each Region with the sum of sales for each product displayed. 

 

g. Remove the Sum of Total Sale field from the Values area. Notice that the PivotTable now appears as a 
structure of rows and columns, but without numerical information to display in each cell. 

5e 
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h. To fill the structure of the PivotTable with values, drag the Quantity field to the Values area. Notice that 
the PivotTable displays the sum of quantities of each product sold in each region. 

 

i. Rename the sheet [Product Totals], key the text [Product Quantities Sold by Region] in cell A1, and merge 
the cell across cells A1 through F1. 

6. To change the layout and style of a PivotTable, select the PivotTable and do the following: 

a. From the Design tab, Layout group, Report Layout drop-down menu, select Show in Tabular Form.  

5g 
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 Note: This may make the information easier to read than the default Compact Form option. 

b. From the Design tab, PivotTable Styles group, More drop-down menu, select Light Blue, Pivot Style 
Medium 2. 

 

One of the advantages of using a PivotTable is that information can be displayed in a variety of ways without 
altering the source data itself. If the values of the source data ever change, the PivotTable can be updated as well 
to display the changes. 

7. To update a PivotTable to include new values or information, do the following: 

a. In the [Sales Data] sheet, update cell A5 to [Garden Veggie Straws] to add a new product not represented 
elsewhere in the data. 

b. In the [Product Totals] sheet, select the PivotTable, then from the PivotTable Analyze tab, Data group, 
Refresh drop-down menu, select Refresh. Notice that [Garden Veggie Straws] is added to the bottom of 
the PivotTable. 

6a 
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 Note: If multiple PivotTables exist in a workbook connected to multiple sources of data, choose the 
Refresh All option. 

c. To sort the Product names, from the drop-down menu in cell A4, click Sort A to Z. 

 

8. Return to the [Sales Data] sheet and create a new PivotTable on a new worksheet using the data in cells A4 
through G54 with the following information: 

a. Place the Region and Salesperson fields in the Rows area, in that order. 

b. Place the Total Sale and Quantity fields in the Values area, in that order. 

c. Notice that the PivotTable shows the sum of Total Sale and Quantity for each region, further broken down 
by each salesperson. 

d. Show the PivotTable in Tabular form. 

e. Change the PivotTable style to Light Blue, Pivot Style Medium 2. 

f. Rename the sheet [Salesperson Totals]. 

7b 
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g. Key the text [Sales Information by Salesperson] in cell A1 and merge and center across cell D1. 

The previous PivotTables in this lesson used expected fields like Product and Salesperson as rows of the resulting 
table. However, the flexibility of PivotTables allows you to try using other fields in the structure of the PivotTable 
to analyze the data for different information. For example, if you wanted to see how many sales each salesperson 
made within a certain dollar range, you could use Total Sale as a row and group the data by the ranges you are 
interested in. This would take the Total Sale field, a numeric field typically used as a value, and instead use it to 
create the rows of the PivotTable. 

When assigning PivotTable fields in this way, it may be helpful to first create the structure of the PivotTable by 
assigning rows and columns, then assign fields as values to fill in the data. 

9. Return to the [Sales Data] sheet and create a new PivotTable on a new worksheet using the data in cells A4 
through G54. 

10. To group PivotTable data to display different ranges of values, from the PivotTable Fields task pane, do the 
following: 

a. Drag the Total Sale field to the Rows area and the Salesperson field to the Columns area. Notice that each 
row represents a different dollar value contained within the sales data. 

 

b. To group the rows so that data is reported for ranges of values instead of each individual value, right-click 
any value in column A of the PivotTable and select Group…. 

10a
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c. In the Grouping dialog box, change the Starting at value to [0] and the Ending at value to [400]. Notice 
that the values will be grouped By every $100, then click OK. 

 

Now that the structure of the PivotTable has been created and the rows are grouped to display the desired ranges 
of values, you can fill in the data by assigning a Values field.  

As you saw in previous examples in this lesson, numeric fields like Quantity and Total Sale default to displaying 
sums when used as PivotTable values. When you assign a text-based field as a value, it will default to showing the 
count for that field. For example, dragging Product to the Values area will display how many sales each 
salesperson made within each dollar range, because this will correspond to the number of rows in the dataset (or 
each individual sale the salesperson made). 

d. Drag the Product field to the Values area. Notice that each cell of the PivotTable displays how many sales 
each salesperson made within the dollar ranges. 

10b
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 Note: By assigning the Product field of the original source data as a value in the PivotTable, it will return
how many total rows of data (or number of sales) fall within each grouped sales range.

e. Change the groupings of rows to start at 0 and end at 400, creating new groups at each $50 increment.
Notice that new rows of data are displayed. 

11. Show the PivotTable in Tabular form and change the PivotTable style to Light Blue, Pivot Style Medium 2.

12. Rename the sheet [Sales by Dollar Range], key [Number of Sales at $50 Increments by Salesperson] in cell A1,
and merge and center across cell J1.

13. Review your finished workbook and proofread all changes made to the file, then resave. 

14. Print or share the workbook if required by your instructor. 
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